INSTALLATION AND SET-UP GUIDE FOR THE CCM SUMMARY

Version 2.0 R1—August 15, 2017

Management tools for the whole-of-country approach

CCM Summary
Regional Dashboard
Principal Recipient Management Dashboard
Subrecipient Management Tool
This publication is made possible by the support of the American People through the U.S. Agency for International Development and the U.S. President’s Emergency Plan for AIDS Relief. GMS is funded by the U.S. President’s Emergency Plan for AIDS Relief and the U.S. Agency for International Development under contract No. AID-OAA-C-12-00040. The contents of this report are the sole responsibility of Grant Management Solutions, and do not necessarily reflect the views of the U.S. Agency for International Development, the U.S. government, or the Global Fund to Fight AIDS, Tuberculosis and Malaria. GMS is a U.S. Government–funded partnership consisting of Management Sciences for Health, Abt Associates, International HIV/AIDS Alliance, Pact, Palladium, Realizing Global Health, Training Resources Group, and committed to strengthening the performance of Global Fund grants.
# CONTENTS

1. Introduction 6
   1.1. Purpose and organization of the User Guide 6
   1.2. What is the CCM Summary and how will it help the CCM in its oversight role? 6
   1.3. How does the CCM Summary work? 7
   1.4. Why and how was the CCM Summary developed? 7
   1.5. Who will be the beneficiaries of the CCM Summary? 9

2. Set-up and management of the CCM Summary—This section is for information-technology and M&E managers 13
   2.1. Key steps to configuring the CCM Summary 13
   2.2. Prerequisites for the appropriate installation and use of the CCM Summary 13
      2.2.1. Files needed to produce the CCM Summary 13
      2.2.2. Equipment requirements 14
      2.2.3. System requirements 14
      2.2.4. Connectivity 15
      2.2.5. Key actors involved in CCM Summary installation and knowledge and skills required 15

3. Step-by-Step instructions for installation, configuration and ongoing use of the data-entry application—this section is for CCM secretariat staff and the CCM Summary administrator 18
   3.1. Installation of the Excel data-entry application 19
      3.1.1. Obtaining and managing data-entry application files 19
      3.1.2. Accessing the menu screen 20
      3.2. Configuration of the Excel data-entry application—Process 1 21
      3.2.1. Step 1: Setup> Go to setup> General information 22
      3.2.2. Step 2: Setup> Go to setup> PR names 22
      3.2.3. Step 3: Setup > Go to setup > Create new PR worksheets 24
      3.3. Excel data-entry application—Process 2: Data collection/uploading PR data 28
      3.4. Excel data-entry application—Process 5: Exporting all the data 30
      3.5. Excel data-entry application—Process 3: Comments 32

4. Step-by-Step instructions for installing SAP software and producing the CCM Summary—this section is for the CCM Summary administrator 35
   4.1. Installing SAP Crystal Dashboard Design 2011 software 35
      4.1.1. Ensuring the version of Excel on the CCM computer is compatible with the CCM Summary software 35
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1.2. Installing the dashboard software</td>
<td>37</td>
</tr>
<tr>
<td>4.1.3. Additional steps to install the CCM Summary</td>
<td>44</td>
</tr>
<tr>
<td>4.2. How to navigate the CCM Summary</td>
<td>46</td>
</tr>
<tr>
<td>4.2.1. Importing pr data into the CCM Summary</td>
<td>46</td>
</tr>
<tr>
<td>4.2.2. Data import into the CCM Summary</td>
<td>48</td>
</tr>
<tr>
<td>4.2.3. Visualization of the CCM Summary</td>
<td>50</td>
</tr>
<tr>
<td>5. Using the CCM Summary for oversight and support of performance</td>
<td>51</td>
</tr>
<tr>
<td>improvement—this section is intended for use by the CCM Summary</td>
<td></td>
</tr>
<tr>
<td>administrator, other CCM secretariat staff and CCM members</td>
<td></td>
</tr>
<tr>
<td>5.1. What is CCM oversight?</td>
<td>51</td>
</tr>
<tr>
<td>5.2. What does the Global Fund require from CCMs to demonstrate adequate</td>
<td>52</td>
</tr>
<tr>
<td>oversight?</td>
<td></td>
</tr>
<tr>
<td>5.3. Elements of adequate and complete CCM oversight</td>
<td>53</td>
</tr>
<tr>
<td>5.4. How can the CCM Summary help the CCM carry out its oversight function?</td>
<td>55</td>
</tr>
<tr>
<td>5.5. What are the key elements required for effective use of the CCM Summary for oversight?</td>
<td>56</td>
</tr>
<tr>
<td>5.5.1. Minimum elements required for effective use of the CCM Summary</td>
<td>56</td>
</tr>
<tr>
<td>5.5.2. Eight-stage process to follow after establishing minimum elements</td>
<td></td>
</tr>
<tr>
<td>6. The CCM Summary in detail</td>
<td>60</td>
</tr>
<tr>
<td>6.1. CCM Summary tab</td>
<td>60</td>
</tr>
<tr>
<td>6.1.1. Introduction and threshold setting</td>
<td>60</td>
</tr>
<tr>
<td>6.1.2. Financial indicator</td>
<td>64</td>
</tr>
<tr>
<td>6.1.3. Programmatic indicator</td>
<td>65</td>
</tr>
<tr>
<td>6.1.4. Analysis of CCM Summary</td>
<td>66</td>
</tr>
<tr>
<td>6.2. Action plan tab</td>
<td>70</td>
</tr>
<tr>
<td>7. Troubleshooting, best practices, frequently asked questions (FAQs)</td>
<td>71</td>
</tr>
<tr>
<td>and the help desk</td>
<td></td>
</tr>
<tr>
<td>7.1. FAQs on the data-entry application</td>
<td>71</td>
</tr>
<tr>
<td>7.2. FAQs on the CCM Summary</td>
<td>73</td>
</tr>
<tr>
<td>7.3. How to get help when working with the CCM Summary</td>
<td>79</td>
</tr>
</tbody>
</table>
### ABBREVIATIONS AND ACRONYMS

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCM</td>
<td>country coordinating mechanism</td>
</tr>
<tr>
<td>Global Fund</td>
<td>Global Fund to Fight AIDS, Tuberculosis and Malaria</td>
</tr>
<tr>
<td>GMS</td>
<td>Grant Management Solutions</td>
</tr>
<tr>
<td>IT</td>
<td>information technology</td>
</tr>
<tr>
<td>KPs</td>
<td>key populations</td>
</tr>
<tr>
<td>LFA</td>
<td>local fund agent</td>
</tr>
<tr>
<td>OGAC</td>
<td>Office of the U.S. Global AIDS Coordinator</td>
</tr>
<tr>
<td>PEPFAR</td>
<td>U.S. President’s Emergency Plan for AIDS Relief</td>
</tr>
<tr>
<td>PLWD</td>
<td>persons living with the diseases</td>
</tr>
<tr>
<td>PR</td>
<td>principal recipient</td>
</tr>
<tr>
<td>PSM</td>
<td>procurement and supply management</td>
</tr>
<tr>
<td>SR</td>
<td>subrecipient</td>
</tr>
<tr>
<td>SRMT</td>
<td>Subrecipient Management Tool</td>
</tr>
<tr>
<td>USAID</td>
<td>U.S. Agency for International Development</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus/flash drive</td>
</tr>
</tbody>
</table>

*User Guide* | *Installation and Setup Guide for the CCM Summary*
1. INTRODUCTION

1.1. PURPOSE AND ORGANIZATION OF THE USER GUIDE

The purpose of this User Installation and Setup Guide for the CCM Summary (User Guide for short) is to help members of the country coordination mechanism (CCM), as well as members of the CCM’s oversight body learn how to install and use a dashboard specifically designed for use by CCMs. This dashboard is known as the CCM Summary.

This User Guide is divided into two major parts: (1) an introduction explaining the origins, purpose, development and plans for the CCM Summary, which comprises sections 1 and 2 of this User Guide, and (2) detailed instructions for installing and using the summary for the CCM, as shown in sections 3-7 of this User Guide.

1.2. WHAT IS THE CCM SUMMARY AND HOW WILL IT HELP THE CCM IN ITS OVERSIGHT ROLE?

The CCM Summary is a dashboard that provides members of the CCM and of the CCM’s oversight body with a user-friendly, highly-visual mechanism for obtaining a snapshot of the performance of grants from the Global Fund to Fight AIDS, Tuberculosis and Malaria (Global Fund) at a given point in time. Through color coding and drill-down capacity, the dashboard serves as a guide for the oversight body’s and CCM members’ analysis of the performance of a country’s grants and giving them an opportunity to detect problems with grant performance early and to take fast action to get the grant back on course.

Dashboards provide a visual display of the most important information needed by leaders and decision makers to monitor progress toward objectives for a project or program. By using dashboard data for timely identification of problems and bottlenecks in program implementation, leaders and decision makers can take corrective actions to improve program performance.

Since the CCM Summary provides information that helps CCM members and CCM oversight body members to examine the PR’s performance while facilitating decision making and the timely implementation of corrective measures to improve performance of country grants, the CCM Summary has the potential to serve as a key instrument in the oversight process.

The objectives of the CCM Summary in the context of CCM oversight are as follows:

- To provide CCM members with data on key financial management, programmatic and PSM indicators for use in grant oversight
- Through the use of standardized indicators and colors that are linked to performance levels, to help CCM members recognize warning signs of aspects of grant implementation that require attention
- To provide an easy mechanism for CCM members to record and archive their recommendations and decisions on follow-up actions needed to improve grant performance
To promote dialogue between CCM members and PR’s about grant management and performance.
To catalyze improved grant performance through the follow-up actions taken by both PRs and CCM members to address problems with grant performance

1.3. HOW DOES THE CCM SUMMARY WORK?

The CCM Summary is produced by two applications that are used together: an Excel-based, data-entry application and a dashboard-display application that use SAP Crystal Dashboard Design 2011 software. When used together, these two applications display the status of grant performance for all PRs in a specific country through financial indicators, procurement and supply management (PSM) parameters, and programmatic indicators that inform the CCM about the vital signs of the country’s grants.

The CCM Summary applications receive information from grant dashboards managed by the PRs for each grant. These PR Management Dashboards use similar applications; PR dashboards must be adopted by the PRs before the CCM Summary can be assembled. Data from the PR dashboards are uploaded into the CCM Summary and displayed using the SAP software. These data, and dialogue with the PRs, lead to recommendations by the CCM’s oversight body, which are entered into a second page of the CCM Summary for display, analysis and use in the CCM decision-making process. The information generated by the CCM Summary can be reviewed periodically (quarterly, six-monthly) and may be used to produce documents routinely submitted to the Global Fund Secretariat, and to contribute to the performance improvement plan that each CCM must provide every twelve months. The CCM Summary may also be used to inform leaders and stakeholders within the country about the status of their grant portfolio.

1.4. WHY AND HOW WAS THE CCM SUMMARY DEVELOPED?

Since 2006, Grant Management Solutions (GMS) has developed three dashboards for Global Fund countries: two dashboard prototypes for PR management (using Excel and Xcelsius) and a grant oversight dashboard for CCMs. The CCM dashboard was piloted with the Global Fund Secretariat in 2009 and may still be seen on the Global Fund’s website at www.theglobalfund.org/en/country-coordinating-mechanism/oversight/. The dashboard for PR management is based on the earlier prototypes, which were introduced in Honduras in 2006 and Nicaragua in 2008.

During 2014, a new, improved version of the dashboard prototypes for PR management was developed in response to findings from the 2012 impact evaluation produced by the introduction of the CCM dashboard. The tool was developed by GMS, the Secretariat of the Global Fund to Fight AIDS, Tuberculosis and Malaria (Global Fund), and a private-sector partner, the German multinational SAP.1 Six PRs in five countries (India, Nepal,  

1. SAP is a German multinational corporation, which was founded in 1972. It specializes in the development of software for the management of business operations and customer relations. SAP is the acronym for Systeme, Anwendungen un Produkte in der Datenverarbeitung [Systems, Applications and Data Processing Products].
Myanmar, the Democratic Republic of Congo, and Honduras) coordinated the validation of the indicators selected for the PR Management Dashboard).

The PR Management Dashboard was piloted in six countries between February and August 2014: Cote d'Ivoire, the Dominican Republic, Laos, Senegal, South Africa, and Uganda.

Using the PR Management Dashboard as a starting point, GMS then designed a summary dashboard for CCMs that would consolidate and display indicators of particular interest to CCMs. Named the “CCM Summary” because it displays a subset of the data imported from multiple PR Management Dashboards, this tool was also developed in collaboration with the Global Fund.

As part of the development process, GMS conducted interviews with CCM members from Bangladesh, Côte d'Ivoire, the Dominican Republic and Uganda to obtain feedback on the relevance of the data displays proposed for the dashboard, as well as on the look and feel of the tool. The Global Fund Secretariat CCM Hub in Geneva provided similar feedback. Once this feedback was integrated into the prototype, the mechanism for importing data from PRs was designed.

Testing of the CCM Summary was then conducted with CCM staff and CCM members from the Dominican Republic and Uganda. The testing in the Dominican Republic CCM was done in-country using data imported from multiple PR Management Dashboards. Staff from the Global Fund Secretariat CCM Hub also participated in this testing exercise. The testing exercises included discussions about possible mechanisms to be established between a CCM and PRs to facilitate regular production and discussion of the CCM Summary.

The CCM Summary electronic files and User Guide were completed in August 2015. Lessons learned during testing exercises described were incorporated into both the software and User Guide. English, French, Portuguese, Spanish, and Russian versions of the software were produced. User Guides were produced in English, French, Portuguese, and Spanish.

The CCM Summary has the following advantages:

- **Is simple to use:** The process of producing the CCM Summary is simple and can be implemented by a person designated by the CCM
- **Uses existing PR dashboard data:** The source data for the CCM Summary is the data from PR Management Dashboard; assuming that the PR is optimizing use of PR Management Dashboard, the CCM summaries generated by the PR dashboard will have up-to-date data that is of good quality

---

2. The PR’s who validated the dashboard indicators were CHF Honduras (Honduras); *Projet Santé Rurale* or SANRU (Democratic Republic of Congo); International AIDS Alliance (India); and Save the Children (Myanmar and Nepal).
• **Can be produced quickly:** Data entry by the CCM is minimal. This is because the most of the data displayed in the CCM Summary is imported using files that PRs provide. Data generation is semi-automated, which minimizes data-entry errors.

• **Does not require additional staff to generate and review:** Existing CCM staff and oversight body members can coordinate to produce the CCM Summary and review its contents.

• **Can be generated frequently enough to provide meaningful input by CCM that improves grant management:** The dashboard may be generated on a periodic basis (quarterly or six-monthly) as agreed between the CCM and PRs.

• **Promotes communication and collaboration between CCM and PRs:** Once the CCM agrees with PRs on the frequency of data submission and modalities for transmitting data, subsequent discussions and feedback using CCM Summary data result in regular communication between CCM and PRs on grant performance.

1.5. **WHO WILL BE THE BENEFICIARIES OF THE CCM SUMMARY?**

The principal beneficiaries of the CCM Summary will be CCMs, since CCMs are responsible for conducting oversight of Global Fund grants. Oversight of grant implementation is a core function of CCMs. Oversight aims at ensuring that Global Fund resources allocated to a country are used efficiently, that programs are implemented as planned, and that they reach the targeted populations. Using this tool, the CCM will be able to follow grants, track their progress and difficulties, and make recommendations on how the PRs can improve grant performance.

Other interested parties that may benefit from the information generated by the CCM Summary are the Global Fund’s local fund agent (LFA), Global Fund country team (which is responsible for monitoring grant implementation), national level decision makers such as the president, prime minister or parliamentarians, national stakeholders such as development partners and associations of key populations (KPs), and international institutions interested in learning about the progress of grants in their respective countries.

1.6. **HOW THE CCM SUMMARY FITS INTO THE WHOLE-OF-COUNTRY APPROACH AND THE SUITE OF MANAGEMENT TOOLS**

The CCM Summary is one of a suite of four management tools created to help Global Fund countries monitor and improve their grant performance. The full suite consists of the following tools in order of creation:

1. PR Management Dashboard, developed by GMS, the Global Fund Secretariat and SAP SE in 2013

2. CCM Summary, developed by GMS

3. Regional Dashboard, developed by GMS

4. SR Management Tool (SRMT), developed by GMS
The Global Fund has adopted the PR Management Dashboard and the CCM Summary; these tools are progressively being made available on the Global Fund’s website at www.theglobalfund.org/en/funding-model/technical-cooperation/management-tools/.

The four tools and their main characteristics are shown in the table on the following page, where the arrows in the left column indicate the flow of data between tools.
<table>
<thead>
<tr>
<th>Management tool</th>
<th>Main characteristics</th>
<th>Data input</th>
</tr>
</thead>
</table>
| CCM Summary          | ➢ Uses an Excel-based application for data entry and an SAP Crystal Dashboard Design 2011 application for visualization  
|                      | ➢ Shows quarterly results by summing PR grant data                                     | Configuration is done by the CCM; PR data are imported from the PR Management Dashboard |
|                      | ➢ Presents indicator data for up to three years                                         |                                                                             |
|                      | ➢ Performance data are organized by component (HIV/AIDS, TB, malaria, HSS) and by PR within each component |                                                                             |
|                      | ➢ Contains section for recording recommendations by CCM oversight body, decisions by CCM and status of implementation of recommended actions |                                                                             |
| Regional Dashboard   | ➢ Uses an Excel-based application for data entry and an SAP Crystal Dashboard Design 2011 application for visualization  
|                      | ➢ Shows quarterly results by summing SR grant data                                     | Data imported from the PR Management Dashboard Excel-based Data Master |
|                      | ➢ Presents indicators data for up to three years                                       |                                                                             |
|                      | ➢ Presents information aggregated by country                                           |                                                                             |
|                      | ➢ Has a map of countries involved                                                     |                                                                             |
| PR Management Dashboard | ➢ Uses two applications - an Excel-based data-entry component and a visualization application that uses SAP Crystal Dashboard Design 2011  
|                      | ➢ Displays overall grant data on one page                                              | PR data entered directly by PR; SR data imported by uploading SR data-entry sheets for each SR |
|                      | ➢ Drill down layer displays quarterly and cumulative life of grant results by SR       |                                                                             |
|                      | ➢ Presents indicators data for three years                                             |                                                                             |
| SR Management Tool   | ➢ Consists of a single, Excel-based application                                         | Following configuration by PR, data entry is done by SRs                   |
|                      | ➢ Configuration is led by the PR in close collaboration with SRs                       |                                                                             |
|                      | ➢ Displays quarterly and annual cumulative data for one year                            |                                                                             |
|                      | ➢ Includes summary of SR performance using both tables and charts                       |                                                                             |
The PR Management Dashboard, CCM Summary and SRMT are interlinked: the SRMT produces sheets that feed into production of the PR Management Dashboard, and the PR Management Dashboard in turn produces files that are used to create the CCM Summary. Two versions of the regional dashboard exist. One is a version of the PR Management Dashboard configured (and possibly modified slightly in design) for regional grants with simple implementation arrangements. The second version is designed for regional grants with more complex implementation arrangements and uses multiple applications—the Excel-based PR Data Master, the Excel-based Regional Data Master and an SAP-based visualization application—to produce the actual dashboard.
2. **SET-UP AND MANAGEMENT OF THE CCM SUMMARY—THIS SECTION IS FOR INFORMATION-TECHNOLOGY AND M&E MANAGERS**

2.1. **KEY STEPS TO CONFIGURING THE CCM SUMMARY**

Below are the key steps for setting up the CCM Summary:

- Installing the data-entry application at CCM level
- Installing the SAP Crystal Dashboard Design 2011 software at CCM level
- Setting up the data-entry application with basic information about the grant including:
  - Language of the country
  - The name of the country
  - The latest update
  - RP Names
- Generating PR data-entry sheets

Sections 3 and 4 of this document lay out these steps in more detail.

2.2. **PREREQUISITES FOR THE APPROPRIATE INSTALLATION AND USE OF THE CCM SUMMARY**

The CCM Summary is designed to be usable in both high information-technology (IT) and low-IT environments. This section describes the files, system requirements, technical requirements, key actors and related knowledge and skills that should be in place and available for effective installation and use of the CCM Summary.

2.2.1. **FILES NEEDED TO PRODUCE THE CCM SUMMARY**

Below is the list of files needed by PRs and CCMs to enable production of the CCM Summary. The Global Fund already makes available the resources in the column entitled: “For the PR” on its website at www.theglobalfund.org/en/fundingmodel/technicalcooperation/prdashboard/

<table>
<thead>
<tr>
<th>For the PR</th>
<th>For the CCM</th>
</tr>
</thead>
<tbody>
<tr>
<td>PR Dashboard Data Master 2.0 R4</td>
<td>CCM Summary Data Master Ver 2.0 R1 (Excel)</td>
</tr>
<tr>
<td>Dashboard Feed 2.0 R4</td>
<td>CCM Data Feed Ver 2.0 R1 (Excel)</td>
</tr>
<tr>
<td>Dashboard 2.0 R4</td>
<td>CCM Summary Ver 2.0 R1 (SAP file)</td>
</tr>
</tbody>
</table>

3. Low IT capacity refers to countries characterized by: poor availability of computers at most levels of their health systems, problems with internet connectivity and bandwidth, as well as weak human and infrastructure capacity to support use of computer technology for data collection, transfer and processing. High IT capacity countries have ready availability of computers at most levels of the health system, and good internet connectivity and speed. Moreover, high IT capacity countries have an adequate supply of human resources capable of using computer technology for data collection, transfer and processing.
2.2.2. EQUIPMENT REQUIREMENTS

To use the dashboard effectively, the CCM secretariat or the tool administrator will need the following equipment:

- Laptop or desktop computer
- Internet connection
- Capability of periodic storage of data files (hard disk, Universal Serial Bus/flash drive (USB), other storage device)
- Color printer

2.2.3. SYSTEM REQUIREMENTS

To use the CCM Summary, the user will need administrator rights to install new software on computers and laptops on which the CCM Summary will be used. Administrator rights are also necessary in case the administrator has to reinstall Microsoft Office to select the version (32-bit) that is compatible with SAP Crystal Dashboard Design 2011.

The CCM secretariat must have the following software versions (any one from the list for each product) already installed on their computer(s), to install and run SAP Crystal Dashboard Design 2011.

**Microsoft Windows**

- Windows XP Professional SP2 and SP3
- Windows Server 2003 standard edition SP1 and SP2
- Windows Server 2003 Enterprise Edition SP1 and SP2
- Windows Vista SP1 and SP2
- Windows 7
- Windows 8
- Windows 10
- Windows Embedded Compact 2013

**Microsoft Excel**

- Excel XP SP3 (or later)
- Excel 2003 SP1, SP2, SP3
- Excel 2007 32-bit version (64-bit is not compatible with the dashboard software)
- Excel 2010 32-bit version (64-bit is not compatible with the dashboard software)
- Excel 2013 32-bit version (64-bit is not compatible with the dashboard software)

- Adobe Reader 11 or later version
- Adobe Flash Player 15 or later version
Antivirus

Updated antivirus software

The administrator will need SAP Crystal Dashboard Design 2011 software. CCMs wishing to adopt use of the CCM Summary will need to request and receive the requisite software license from the Global Fund Secretariat. The Global Fund will maintain a list of licenses issued to CCMs. CCMs will need to ensure that any SAP license that is issued to it remains in the possession of the CCM in the event that CCM members or staff resign or change computers.

2.2.4. CONNECTIVITY

It is assumed that any computers used by a CCM for purposes of generating the CCM Summary would have access to a functional internet connection. In cases where the internet connection is not reliable, however, files can be transferred using USB flash drives or CD-ROMs. It is desirable that PRs also have access to a functional internet connection to facilitate transmission of files to the CCM.

2.2.5. KEY ACTORS INVOLVED IN CCM SUMMARY INSTALLATION AND KNOWLEDGE AND SKILLS REQUIRED

It is recommended that the CCM secretariat coordinates and implements the whole process of generating CCM summaries, and that an individual from the CCM secretariat be appointed as the CCM Summary coordinator to implement the process. The table below identifies key staff from the CCM and other stakeholders who would be involved in installation and setup of the CCM Summary, and outlines their key responsibilities and the requisite knowledge and skills.

The following table summarizes the key actors and competencies required to ensure effective configuration and use of the CCM Summary.

4. In 2015, SAP developed a more updated version of SAP Crystal Dashboard Design 2011 that is called SAP Business Objects 4.1 Support Pack 6. Use of SAP Business Objects 4.1 Support Pack 6 resolves compatibility issues with Office 2013 that some users have encountered. At printing of this manual, SAP was working to stabilize the link for downloading SAP Business Objects 4.1 Support Pack 6. Users are therefore encouraged to periodically check the Principal Recipient Management Dashboard page on the Global Fund website for updates on how to download this newer version of the software as well as for any other updates on software files, user guides or instructions.
<table>
<thead>
<tr>
<th>Actor</th>
<th>Key responsibilities for CCM Summary configuration and use</th>
<th>Skills, knowledge and attitudes required</th>
</tr>
</thead>
</table>
| CCM chair                  | • Assign the responsibility for producing the CCM Summary to the CCM secretariat, executive committee or oversight body  
• Agree with and communicate to the PRs the dates on which PR Dashboard files are to be submitted to the CCM secretariat or to the CCM executive committee to produce the CCM Summary  
• Hold oversight meetings to review the grant results  
• Participate in decision-making meetings to improve grant implementation  
• Follow up on decisions made by the CCM to improve grant implementation | • Knowledge of the grants in the country                                                                                      |
| CCM Summary administrator  | • Complete the process of importing PR Dashboard files into the CCM Summary Data Master  
• Produce the CCM Summary display and transmit to the oversight body in a timely manner  
• Develop presentations for meetings with the oversight body to review CCM Summary results  
• Document comments and recommendations from the oversight body and take note of remarks and suggestions  
• Develop presentations for meetings with the CCM to review the CCM Summary and take note of any decisions  
• Update and provide follow-up to the action plan  
• Monitor submission of data by the PRs, including data quality  
• Ensure the appropriate archiving and safekeeping of CCM Summary files  
• Perform regular backups of CCM Summary data  
• Ensure timely transmission of the CCM Summary to the CCM  
• Manage the analysis, review and update of the action plans and comments | • Competency and comfort level with using computers  
• Competency in SAP Crystal Dashboard Design 2011, Microsoft Excel, file safeguarding, internet use  
• Thorough familiarity with grant activities  
• Handling and preparation of PowerPoint presentations  
• Demonstrated understanding of the oversight process  
• Ability to structure and facilitate analytical meetings |
<table>
<thead>
<tr>
<th>Actor</th>
<th>Key responsibilities for CCM Summary configuration and use</th>
<th>Skills, knowledge and attitudes required</th>
</tr>
</thead>
</table>
| Oversight body| • Hold meetings with PRs to analyze grant performance results  
• Where necessary, request to see full PR dashboard to obtain additional details on grant performance  
• Participate in analytical meetings with the PRs and provide comments about the CCM Summary  
• Conduct visits to validate CCM Summary data provided from PR  
• Present CCM Summary data at CCM meetings along with related comments and recommendations  
• Participate in decision making by full CCM on follow-up actions to be taken to improve grant performance  
• Integrate decisions from CCM into the CCM action plan  
• Follow up to ensure that decisions in action plan are implemented | • Basic knowledge on the Global Fund grant cycle  
• Technical expertise in implementation of disease programs and related indicators (will depend on types of grants being implemented by the country  
• Expertise in monitoring and evaluation  
• Understanding of how to interpret PR dashboard indicators  
• Good rapport and effective communication with the PRs and members of the CCM  
• Willingness to discuss and consider a range of implementation issues that may arise and to seek relevant solutions to recommend to the PR |
As mentioned in the previous sections of this manual, the CCM Summary comprises two elements—the data-entry application and the dashboard-display application—which must be used sequentially. The CCM Summary receives data from the PR Management Dashboard(s); these PR dashboards must be installed and be functional before the CCM Summary can be used.

The diagram below—which assumes the PR dashboards already exist—guides the user through specific steps to set up and use the CCM Summary. The steps required to produce the dashboard mirror the flow of data in the oversight process and action plan. The CCM Summary administrator must follow all the steps in the correct order to effectively produce a dashboard. This diagram represents all the steps described in sections 3 and 4 of this manual.

Proposed Approach to Using the CCM Summary to Enhance CCM Oversight

Section 3 describes the use of the data-entry application at steps 1, 2, 4 and 5 in the diagram above. Subsections 3.1 to 3.6 walk the user through installation, setup and use of the data-entry application.
Section 4 explains the process for producing the data visualization using the dashboard-display application using SAP Crystal Dashboard Design 2011.

A more detailed diagram of the process of the CCM Summary is included in Section 5 of this User's Guide. Section 5 describes decision making at steps 3, 6, and 7 in the diagram above.

3.1. INSTALLATION OF THE EXCEL DATA-ENTRY APPLICATION

This section explains how to obtain and install the data-entry application, which is one of the two major elements of the CCM Summary.

The data-entry application is an Excel spreadsheet that will enable the CCM Summary's administrator to complete the following five processes:

1. Set up basic information for the PR
2. Import PR data into one master data sheet
3. Enter comments related to grant results
4. Create the action plan
5. Automatically export data to the CCM Summary

An additional file—the CCM Summary feed file—is used with the data-entry application to export data to produce the graphic summary.

3.1.1. OBTAINING AND MANAGING DATA-ENTRY APPLICATION FILES

The CCM Summary administrator will obtain the data-entry application file either from the technical team assisting him or her with introducing the dashboard on a USB, or directly from the Global Fund website.

To begin the process of setting up a file structure for the CCM Summary and of uploading the data-entry application and dashboard feed file, it is very important that the administrator receive from the PRs the files that should be entered into the CCM Summary. GMS recommends that once these files have been received the administrator carry out the following steps:

A. Create a folder in the computer hard disk where the CCM Summary will be hosted. This folder will be named CCM Summary
B. Create a subfolder in the CCM Summary folder named Master Files
C. Create similar subfolders under CCM Summary for each PR and each fiscal year, effectively setting up a logical file architecture for all CCM Summary-related files.

A sample file architecture follows:

A. CCM Summary
B. CCM Summary \ Master Files_Version [XXX]\
Following the sample architecture above, an example of file naming might be as follows:

A. CCM Summary
B. CCM Summary \ Master Files_Version [XXX]
C. CCM Summary \ Master Files_Version [XXX] \ Malaria \ Ministry of Health
D. CCM Summary \ Malaria \ Ministry of Health \ Date of the 2_27_June_2015 period

The CCM Summary administrator may prefer to use a different file architecture with different file-naming conventions. This is fine. What matters is that the administrator create a system for naming and archiving all files related to the CCM Summary that (1) is unique, (2) follows a logic that makes sense to its users, (3) is easy to read quickly, and (4) is always easy to use and is always used. The administrator may want to consult best practices on naming conventions; several guides can be found on the Internet by Googling “file naming conventions.”

3.1.2. ACCESSING THE MENU SCREEN

When the administrator opens the CCM Summary Data Master Excel file that has been copied, the MENU page appears showing five processes to be followed, as well as a log to enter any changes.

NOTE: On occasion the Excel version in use may show the following message at the top of the screen: “Safety warning: macros are disabled” along with a window with options.

If this occurs, enable macros and press the “Accept” button.

The Menu Screen will appear as shown below:
3.2. CONFIGURATION OF THE EXCEL DATA-ENTRY APPLICATION—PROCESS 1

The administrator will follow the steps that appear on the data-entry application menu. Choose “Go to Setup” to begin this process.

Within the Configuration box, two additional buttons will appear: “Go to Setup” and “Remove PR Sheet.”

The Go to Setup button is essential to generate the CCM Summary, since it allows for definition of the language, country, currency and PR data entry.

Below are step-by-step instructions for the administrator for each of the options included in the submenu screen.

When configuring the data-entry application, remember to refrain from cutting and pasting data into the CCM Summary, since cutting and pasting could disturb the programming in the Excel sheets.

Setup > Go to Setup
When "Go to Setup" is selected, the following screen showing the two configuration steps or options appears:

The setup button provides a submenu (enlarged in the above graphic), which depicts all three steps to be carried out to complete the configuration. Initially, the first step will have a yellow exclamation mark next to it. The subsequent steps will each have an “X”
next to them. As soon as the administrator begins to enter data under "General Information," a “✓” will appear next to every menu item. As each step is completed, a “✓” will appear to indicate successful completion. If an “X” appears instead, this indicates that the step has not been completed. All steps should be marked with a “✓” before the data-entry application can be used.

This screen also shows a large black arrow, which reads Return to MENU. Click on this arrow to return to the main menu.

Below are step-by-step instructions for the administrator for each of the options included in the submenu screen.

3.2.1. STEP 1: SETUP> GO TO SETUP> GENERAL INFORMATION

Step 1, selecting General Information, enables entry of general information about the country.

Some cells require that the person setting up the dashboard enter text directly while other cells have drop-down menus. "General Information" includes information such as language, country, currency and latest update. Data in the "Latest update" cell are automatically generated.

Data that is automatically generated in the “Last Updated” cell comes directly from the "Activity Log" on the Menu page of the data-entry application. Therefore, it is important for the administrator to update the “Activity Log” each time to ensure that the “Last Updated” data is picked up for display on the CCM Summary.

Remember to save your work!

3.2.2. STEP 2: SETUP> GO TO SETUP> PR NAMES

Step 2 for PR Names requires that the CCM Summary administrator enter the names of all PRs with active grants that are running PR Management Dashboard in the country. Up to 49 PR names may be entered. Although this sheet has several columns, only the shaded column should be filled in. In the shaded column, each row has a 50-character limit.

Before PR names are entered, the sheet appears blank as follows:

5. Cells with drop-down menus
Important information—concerning the row named Data PR 001:
The "Data PR 001" row is used as a template for the creation of the rest of the PRs. **Users MUST NOT TOUCH** any of the cells in the row for PR 001, including cells H5, I5, J5, K5, L5, and M5 under the **CCM Setup** tab.

When creating PR worksheets, it is mandatory to put the PR name in the H column first (Step 2) before proceeding to step 3, "Create New PR worksheets." If the user executes these actions in reverse order, the data-entry application will show an error message. The PR names should be identical to the names and abbreviations used on the PR Management Dashboard.

In the screenshot below, PR names have already been entered. However, before a user begins to enter names under the "CCM/PRs Names" column, the "PR Names" menu item will display an "X" next to it. When a user enters PR names in the "CCM/PRs Names" column, the "X" becomes a "✓."
Once PR names are entered, information for the other columns is automatically generated. DO NOT manipulate these columns. The user can then proceed with step 3—Create New PR Worksheets.

Remember to save your work!

3.2.3. STEP 3: SETUP > GO TO SETUP > CREATE NEW PR WORKSHEETS

This step of the Setup submenu is a macro that automatically executes several default processes.

Step 3, Create New PR Worksheets, enables creating spreadsheets for each PR entered in the PR Names section, in Step 2. When Create New PR Worksheets is selected, Excel executes a process that will automatically generate a data-entry worksheet for each PR added in the previous step.

Once the Create New PR Worksheets button is pressed, a dialogue box appears listing the PRs for which worksheets are to be created, as shown below.
When the dialogue box above appears, the user then presses “OK.”

After OK is pressed in the Creation of new PR worksheet complete dialogue box shown above, the “X” then disappears and a “✓” appears instead, indicating that the sheet creation process is complete. This process will take a few minutes. Once the process is completed, a tab corresponding to each PR should appear at the bottom of the screen as shown in the section of the screenshot below that is circled in red. Note that the name of each PR will appear in the tab for each PR worksheet as shown below.

There may be instances where the administrator decides to add more PRs after finishing the PR worksheets creation process. In this case, all the user needs to do is enter the new name in the list and press Create New PR Worksheets (Step 3) once again.

After entering the name of a new PR, click OK and a new dialogue box will appear to confirm the addition of the new PR as shown below.
When the user clicks on OK, the dialogue box appears indicating completion of the new PR. User should click OK in the dialogue box.

Alternatively, the user may add PRs at this stage by first entering the PR name in the light orange section and subsequently clicking on Create new PR Worksheets. A dialogue box will appear that says "Hide/Show rows based to the current mapping?" The user must click OK to complete the worksheet creation process.

If the administrator needs to add several PRs during configuration, the process described above will need to be repeated until all PRs are added.

One trick for checking whether the new PR worksheets have been created correctly is to check whether the PR name appearing in column J corresponds to the name in column H.

Remember to save your work!

Setup > Delete PR's Worksheet

In exceptional situations, it may be necessary for the administrator to delete one or several PRs. As much as possible, however, data on a dropped PR should remain within the data-entry application to ensure that historical data on the grant is complete.

Should it become necessary to delete a PR, it would be advisable to restart the Setup process and enter only the active PRs (this does not entail much work). Alternatively, the CCM Summary administrator can use the Remove PR worksheet option to remove PRs already entered.

The Remove PR worksheet option on the Menu page is the button that allows deletion of PR data-entry sheets. When this button is pressed, the application will show a dialogue box that permits elimination of the PR or deleting all previously created PRs.
If the user wishes to delete a PR worksheet, the user will have to select the PR from the list and confirm its deletion. If the user wishes to delete all PR worksheets, the user will need to select the option **Eliminate all PRs created** and confirm its deletion as shown below.

The following example shows the deletion of the "Malaria Program" worksheet. Pressing "OK" will delete the worksheet.
Once all steps in this section 3.5.1 are completed, the administrator presses the Return to MENU button and returns to the Main Menu.

3.3. **EXCEL DATA-ENTRY APPLICATION—PROCESS 2: DATA COLLECTION/UPLOADING PR DATA**

The PRs will probably send their data worksheets to the CCM as email attachments in Excel, or bring them to the CCM secretariat on a USB. These worksheets should be saved in the administrator's computer. Once all the data worksheets sent by the PRs are received for incorporation in the CCM summary, the administrator will proceed to upload the files to the data-entry application. This is done by pressing the button **Load PR Data** in the second menu option entitled **Data Collection** shown in the following diagram.

When the button for option 2, **DATA COLLECTION>Load PR Data** is pressed, the application will show a window where the administrator may select the appropriate file submitted by each PR, previously saved in the corresponding folder.

The administrator will select the file to be uploaded and press **Open**.
Next, the application will display **a few security questions** to ensure that the file being imported from the PR corresponds to the correct PR tab in the CCM Data Master. The first question associates the PR’s name appearing in the file sent by the PR with the name in the PR list that appears in the application, since it is possible that the name defined by the administrator in the PR list may not be spelled the same as in the file the PR sent.

Pressing "Yes," will cause the PR list to appear. Then the administrator may select the PR for which data in the selected file will be loaded:

To make sure there is no mistake with the selected file and PR name, a question appears asking the user to confirm the selection:
It is extremely important for the CCM Summary administrator to ensure that the file being imported corresponds to the correct PR designation. This will prevent one PR’s data from being imported into another PR’s tab in the CCM Data Master.

Once this confirmation process is complete, the following message will appear: Data import complete. This process of importing data usually takes a few seconds for each PR.

The CCM Summary administrator will press OK and then repeat this action for each of the PRs in the menu above until all updated data-entry sheets have been uploaded to file CCM Summary Data Master.

It is recommended that the CCM Summary administrator save the files imported from PRs in separate folders organized by reporting period. Please refer to section 3.1.1, which proposes an approach to organizing files associated with use of the CCM Summary.

3.4. EXCEL DATA-ENTRY APPLICATION—PROCESS 5: EXPORTING ALL THE DATA

Once all PR data-entry sheets are uploaded onto the application, the CCM Summary administrator will be ready to export the files needed to produce the visualization of the CCM Summary data.

The file export process generates an Excel worksheet that will update the CCM Summary created using SAP software. This step is performed by pressing button 5) Enter Data to Dashboard>Export all data.

When this is done, the administrator will see a window showing the destination folder where the export file will be saved as shown below:

Select the name of the destination folder and press Open.
The administrator has two files, "CCM Data Feed Ver 2.0 R1" and "CCM Data Master Ver 2.0 R1." The administrator must select the file named "CCM Data Feed Ver 2.0 R1" from his/her documents library, as shown in the following box:

Once selected, the ensuing process will take a few seconds and then display the following message: **Data export complete.**

The last step in this process is for the CCM Summary administrator to record the date changes were made, the name of the person who made changes, and all changes made. An example is shown below. The administrator must then resave the file using the file’s original name. **The file should not be renamed.**

**NOTE:** This step must be repeated after steps 3 and 4 (in the diagram at the beginning of section 3 of this guide) to incorporate the comments and recommendations.
3.5. **EXCEL DATA-ENTRY APPLICATION—PROCESS 3: COMMENTS**

The step for entering data under **Comments** is carried out at a different time from the entry of data for processes 1 and 2, usually during or following a CCM oversight body meeting.

To obtain the data that will be entered under Process 3: **Comments**, the CCM Summary administrator, members of the CCM oversight body and the PRs will need to meet to discuss the results displayed in the CCM Summary and other information the PRs may provide. CCM oversight body members may ask PRs to display their PR Management Dashboard (s) for the respective time period to get a more detailed appreciation of a grant’s performance. During this discussion on the results of grant implementation, the CCM Summary administrator and oversight body members will make note of issues that should be brought to the attention of the full CCM and will enter these notes in the **Comments** section of the **CCM Summary Data Master**. To access the **Comments** section, the CCM Summary administrator will need to press the "Comments" button.

The “Comments” sheet is organized by disease component. As shown in the chart below, the following information is entered on the comment sheet: the date the meeting was held, the name of the person responsible for comment, and the comment itself. The date should be entered using the following format: MONTH/DAY/YEAR.

During the same discussion, the CCM Summary administrator will also proceed to complete the first part of Process 4, which involves entering the recommendations resulting from this discussion into the **Action Plan** section of the **CCM Summary Data Master**.
3.6. **EXCEL DATA-ENTRY APPLICATION—PROCESS 4: ACTION PLAN**

Process 4 involves entering data into the **Action Plan** section of the data entry application. In terms of timing of entering data into the **Action Plan**, the first part of Process 4 is carried out at the same time as Process 3, which was described in the previous section.

During the same meeting described under Process 3 in which the CCM Summary administrator, CCM oversight body members and PPRs discuss grant performance, CCM oversight body members will make recommendations for actions to be taken to improve grant performance or to mitigate risks facing grants. Comments related to implementation concerns noted by the CCM oversight body will already have been recorded in the Comments section under Process 3. In the first part of Process 4, the CCM Summary administrator will enter recommendations related to these comments into the Action Plan section of the CCM Summary Data Master.

After the comments and recommendations are entered into the CCM Summary Data Master, **the administrator must save these changes and complete the step in section 3.5 again** in order to display the Comments and Recommendations in the CCM Summary. (See section 3.5.)

The second part of Process 4 occurs during a full CCM meeting, when members of the CCM oversight body present data from the CCM Summary with comments and recommendations to all CCM members. During its meeting, the CCM makes decisions based on the recommendations from the CCM’s oversight body. These decisions are entered in the relevant column in the Action Plan section of the CCM Summary Data Master.
Master. Also entered at this time is the name of the person responsible for carrying out each decision, and the deadline for taking the action(s) associated with it.

Again, once the Action page of the CCM Summary Data Master is filled with the CCM's decisions, the administrator must save these changes and complete the step in section 3.5 to display the decisions in the CCM Summary.

As the CCM oversight body follows up on the implementation of recommendation actions, the CCM Summary administrator will complete the “Status” column of the CCM Summary Data Master. The status column has a drop-down list with the following options: "Complete," "Incomplete but still within deadline," and "Incomplete, outside deadline.” After each change, the administrator will save and export the updated CCM Summary.
4. **STEP-BY-STEP INSTRUCTIONS FOR INSTALLING SAP SOFTWARE AND PRODUCING THE CCM SUMMARY—THIS SECTION IS FOR THE CCM SUMMARY ADMINISTRATOR**

This section follows section 3. Section 3 explains how to configure the data-entry application for the CCM Summary and how to import PR data and export the data for the purposes of producing the CCM Summary.

This section explains how to install SAP software, import PR data into the SAP application and produce the visualization of PR data for use by the CCM or other stakeholders.

In the diagram below, this section 4 corresponds to step 3 below.

### Proposed Approach to Using the CCM Summary to Enhance CCM Oversight

1. **1 Step** PRs send their "Data Feed" files to the CCM Summary administrator

2. **2 Step** The CCM summary administrator imports each PR’s "Data Feed files" into the "CCM Summary" file

3. **3 Step** The CCM Summary administrator produces the CCM Summary

4. **4 Step** The CCM oversight body meets with PRs to analyze the data from the CCM Summary

5. **5 Step** The CCM oversight body enters its comments and recommendations into the CCM Summary

6. **6 Step** The CCM oversight body presents the CCM Summary, including its comments and recommendations, to the full CCM

7. **7 Step** The full CCM makes decisions on what should be done to improve grant performance or to address implementation bottlenecks. Decisions are recorded in the CCM's action plan

8. **8 Step** The CCM oversight committee follows up on implementation of the decisions recorded in the action plan

### 4.1. INSTALLING SAP CRYSTAL DASHBOARD DESIGN 2011 SOFTWARE

#### 4.1.1. ENSURING THE VERSION OF EXCEL ON THE CCM COMPUTER IS COMPATIBLE WITH THE CCM SUMMARY SOFTWARE
Before installing SAP Crystal Dashboard Design 2011, the CCM Summary administrator will want to ensure that the computer being used to generate the CCM Summary is running a 32-bit version of Excel (see system requirements in section 2 of this User’s Guide). The first part of this section 4.1.1 explains how to check which version of Excel exists on a given computer.⁶

First, open any Microsoft Office application installed in your computer. In the example below, Word 2010 is being used, but the instructions apply also to lower versions of Office 2007; 2003) the other Office applications. Open the File menu, and then select Help.

A window will appear with information about your version of Microsoft Office. It will show the suite version and included applications, as well as your specific version number and product ID.

Under “Office Updates” you should see the version number. To see both version and platform, click About Word to see the information you need. This information will be displayed as follows:

In the example below, the version is listed as follows:
Version: 14.0.4760.1000 (32-bit)

⁶ In 2015, SAP developed a more updated version of SAP Crystal Dashboard Design 2011 that is called SAP Business Objects 4.1 Support Pack 6. Use of SAP Business Objects 4.1 Support Pack 6 resolves compatibility issues with Office 2013 that some users have encountered. At printing of this manual, SAP was working to stabilize the link for downloading SAP Business Objects 4.1 Support Pack 6. Users are therefore encouraged to periodically check the Principal Recipient Management Dashboard page on the Global Fund website for updates on how to download this newer version of the software as well as for any other updates on software files, user guides or instructions.
If the CCM Summary administrator's computer has a 64-bit version of Excel, the administrator will need to uninstall the 64-bit version of Microsoft Office. The administrator will then need to reinstall Microsoft Office and select the 32-bit version upon reinstallation.

To reinstall Microsoft Office, the person with administrative rights to the computer where SAP Crystal Dashboard Design 2011 software is to be stored and used must be available to provide the password to execute this process. The CCM Summary administrator should follow the instructions provided on the Microsoft website for uninstalling and reinstalling Microsoft Office. Once the correct version of Microsoft Excel is installed (32-bit), the CCM Summary administrator will be ready to install SAP Crystal Dashboard Design 2011.

### 4.1.2. INSTALLING THE DASHBOARD SOFTWARE

If the CCM is receiving technical support to do configuration of CCM Summary files, the technical support team will help the administrator with the installation process. The administrator will have already created a folder called CCM Summary (see section 3.1.1 of this User’s Guide) before installing the data-entry application. The technical support team arrives in the country with a USB file containing the zip file 51049596 and will install this file into the CCM Summary folder created by the CCM Summary administrator. If internet connectivity is good, the technical support team can alternatively also help the administrator download zip file 51049596 from the following link:

https://www.dropbox.com/s/kh74jqwk8awswjw/51049596.zip?dl=0

Once the file is downloaded, carry out the following steps:

1. Right click on the title of the ZIP folder
2. Choose to extract all files
3. Double click on **Data Units**
4. Double click on **Xcelsius**
5. Open **Setup** application (shown in the following screenshot). The name of the file may also appear as setup.exe. The name of the file may also appear as setup.exe.

![Screenshot of file explorer](image)

Double click instead or right click on the file, and select **Open**.

A dialogue box will appear which shows that the dashboard software is being installed.

When this process ends a new window will appear asking for language selection as shown below. Choose your preferred language for set up and press “**OK**.”

![Language selection dialog](image)

You will now see a “welcome” screen. Select **Next** to access a new window showing a list of requirements to install the software.
Please carefully review the list you now see on the page titled "Prerequisite check," to make sure that there is no conflict with system requirements. If there is a conflict with the system, the word “Failed” will appear under the Status column. In case of conflict, you may stop the installation process by clicking Cancel. You should then take the necessary action (e.g., install correct version of Adobe Flash Player) to resolve the conflict, before resuming installation of SAP Crystal Dashboard Design 2011.

If there is no conflict, the world “Succeeded” will appear under the status column for every item listed under the “prerequisite” column and you should click Next to continue installation.

After clicking Next, the license agreement page will appear, as shown below. Accept the terms of the license agreement by clicking on Next.
Then the following screen will appear asking you to specify the “destination folder.” This is the folder or directory on the computer where the software you are installing will be saved. Confirm is done by pressing Next. If the default folder that appears is not the place where you wish to save the software, you will need to click on “browse” to select the correct destination folder. Once the folder has been specified, click on Next.

Clicking Next makes a new screen appear asking for the user’s name and product key as shown in the screen below. It is recommended that the CCM enters its complete name and country under the fields “Full Name” and “Organization.” The CCM Summary administrator must enter the software license number provided by the technical support team in the “Product Keycode” field as shown below will provide. Once this information is entered, click Next to bring up the next screen.
The next screen that appears asks you to “choose language packs,” as shown below. English will already be selected as a default language. You may add Spanish or French or some combination of these languages, depending on what languages you will need to use in your country. Note that although other languages are listed, they are not available for selection. Click **Next** once the languages you require are selected.

The following screen appears asking users to choose the type of installation. When this screen appears, “**Typical**” will be the default selection, and this is the installation that should be used. Once “**Typical**” is selected, click on **Next**.
The next screen allows the user to start the installation process. The user should click on **Next** to begin the process.

Next, installation begins, and a blue bar appears in the middle of the screen showing how quickly this step is completed, as shown below.
The following screen on the following page will then appear as the software is launched.

At the end of the installation you will see the following screen. Follow the directions on the screen, and when you click on **Finish** you will complete the software installation on your computer.
4.1.3. ADDITIONAL STEPS TO INSTALL THE CCM SUMMARY

Once you have installed the SAP software on your computer, please take the following steps to complete set-up of the CCM Summary.

1. Open SAP Crystal Dashboard Designer 2011 by pressing the icon under the All Programs menu

2. Once the software is open, Click on the “File” menu

3. Once the File menu is open, select New and then New again. See the screenshot below.
4. Change Language Setting, if needed as follows: Select File -> Select Preferences> Select Languages> Select Current Language > Change English to French or to Spanish. By changing the language, the user will cause all labels in the software to appear in the selected language. Users will therefore want to select their preferred working language during this step. Notice that the language choices mirror the language packs that were selected during installation of the software.
4.2. HOW TO NAVIGATE THE CCM SUMMARY

4.2.1. IMPORTING PR DATA INTO THE CCM SUMMARY

This section explains how to import data into the CCM Summary. The numbered steps below match what is shown in the numbered images in the flowchart that follows.

1. Click on the icon in the far lower left side of your computer and select the icon for SAP Crystal Dashboard Design 2011 under the All Programs menu.
2. A screen appears displaying the word "Dashboards."
3. Open the program by pressing File on the upper left corner of the screen and select Open.
4. A dialogue box will appear with a file library. Select the “CCM Summary 2.0 R1” file.
5. The CCM Summary file opens. This file contains the design for the CCM Summary; therefore, you do not need to make any changes or modifications to it.

** Please note: In some instances, you must choose Right click → Run as administrator for dashboards in order to get this program to work. This is due to a lack of permissions on the host computer.
4.2.2. DATA IMPORT INTO THE CCM SUMMARY

This section explains how the administrator imports PR data, so that CCM Summary visualization can be generated.

From the menu, the administrator selects the icon that means “import Excel sheet” and presses Yes.
Next, the administrator selects the file **CCM Data Feed**, where the most recent PR data are stored.

A few seconds later, the CCM Summary will display the updated PR data.
4.2.3. VISUALIZATION OF THE CCM SUMMARY

The software for the CCM Summary allows generation of output files in different formats, which may be selected by checking menu options or by clicking File>Export. Each possible format is listed below with a brief explanation of how to use that format.

Available options include:

Flash (SWF): to preview
AIR: to download using Adobe Flex software
HTML: to preview using Internet Explorer
PDF: to create a file that can be submitted in a report
PowerPoint: to create a “PPT” slide that can be used in a PowerPoint presentation
Outlook: to be attached to an email
Word: to be used as a report or annex
5. USING THE CCM SUMMARY FOR OVERSIGHT AND SUPPORT OF PERFORMANCE IMPROVEMENT—THIS SECTION IS INTENDED FOR USE BY THE CCM SUMMARY ADMINISTRATOR, OTHER CCM SECRETARIAT STAFF AND CCM MEMBERS

This section puts the use of the CCM Summary into the larger context of the CCM’s responsibility for conducting oversight on Global Fund grants. After defining oversight, explaining its key components, and explaining what the Global Fund requires CCMs to do at a minimum when conducting oversight, this section proposes a process to be followed by CCMs when using the CCM Summary in its oversight activities.

5.1. WHAT IS CCM OVERSIGHT?

Oversight is one of the core functions of CCMs and comprises all activities carried out by the CCM to ensure that:

- Grant performance is adequate
- Policies and procedures are followed
- PRs set up and implement financial controls
- PRs receive feedback and recommendations from the CCM on their performance
- Constituencies represented on the CCM provide inputs and receive information on program implementation and corresponding results

The Global Fund strongly recommends that all CCMs facilitate and/or participate in the following oversight-related activities, which relate to both grant preparation and grant management. These include but are not limited to: ⁷

- Preparing concept notes to apply for Global Fund funding
- Coordinating the country dialogue process
- Supporting PRs during the process of grant making and signature of grant agreements
- Conducting routine oversight, including site visits
- Responding to queries and comments from Global Fund audits or investigations of grants as necessary
- Exercising strategic oversight during reprogramming exercises

---

5.2. WHAT DOES THE GLOBAL FUND REQUIRE FROM CCMS TO DEMONSTRATE ADEQUATE OVERSIGHT?

The Global Fund has established six eligibility requirements that countries must fulfill to access grant funds. The third eligibility requirement is related to oversight by CCMS and reads as follows:

**Requirement 3**: Recognizing the importance of oversight, the Global Fund requires all CCMS to submit and follow an oversight plan for all financing approved by the Global Fund. The plan must detail oversight activities, and must describe how the CCM will engage program stakeholders in oversight, including CCM members and nonmembers, and in particular nongovernment constituencies and people living with and/or affected by the diseases.  

Eligibility requirement #3 has three operational components that CCMS are required to comply with. They are the following:

1. The CCM must have an oversight plan detailing specific activities related to carrying out oversight as well as which individuals or constituencies are responsible for each activity

2. The CCM must establish a permanent oversight body whose members have the skills and expertise to conduct periodic oversight

3. The CCM’s permanent oversight body should periodically seek feedback from nonmembers of the CCM and from people living with and/or affected by the diseases

Linked to these operational components are three minimum standards. The Global Fund reviews CCM compliance with these standards periodically. The minimum standards are as follows:

1. The CCM’s permanent oversight body is to conduct oversight activities, discuss challenges with each PR and identify problems, potential reprogramming and corresponding reallocation of funds between program activities, if necessary. The Global Fund requires that documentation be kept of key proficiencies and a record of members’ designations. CCMS have to submit evidence of consultations and/or field visits to review of grant performance. CCMS must also submit a record of meetings held for performance analysis purposes between the PRs and the oversight body

2. The CCM is to make decisions and take corrective action whenever problems and challenges are identified. CCMS are required to document recommendations made

---


to help resolve challenges faced by PR throughout its programmatic and financial management process.

3. The CCM shares oversight results with the Global Fund Secretariat and in-country stakeholders quarterly through the process defined in its oversight plan. CCMs are required to provide evidence that oversight results are disseminated within the country and at the Global Fund level.  

5.3. ELEMENTS OF ADEQUATE AND COMPLETE CCM OVERSIGHT

As mentioned earlier in this section, CCM oversight comprises a set of activities aimed at ensuring that Global Fund resources—financial as well as human—are used efficiently to a country’s benefit.

The following section expands on the elements that should be considered or included in CCM oversight to ensure that it is adequate and complete:

Stewardship: The notion that the CCM has the unique obligation to organize a strategic approach to the oversight of the management of Global Fund grants and encourage appropriate use of the resources being provided to the country through the Global Fund, even though the CCM does not itself control the resources it has helped secure for the country. The element of stewardship in implementation of oversight ties with the Global Fund’s recognition that all institutions (CCM, PR, SR, LFA and the Global Fund Secretariat) contribute to the same goal of reducing the impact of HIV/AIDS, tuberculosis and malaria.

Complementarity of PR and CCM roles: The oversight role of a CCM is different from that of a PR. A CCM must understand grant performance at a strategic level, without immersing itself in operational details, which is the PR’s job. As such, the oversight function requires that the CCM do the following: understand the key components and expected outcomes of each grant; know how well each grant is performing; follow up on problems with grant implementation as they arise; make recommendations to PRs on actions to take so that expected grant results will be achieved; and, ensure that the PR works with all relevant institutions in the country (e.g., Central Medical Stores) to resolve problems with implementation.

Capacity and time to track and follow up on grant performance: In order to ensure efficient and effective implementation of oversight activities, every CCM is required to set up an oversight body. An oversight body must have the right mix of professional knowledge and skills as well as experience to conduct oversight adequately. Moreover, all CCM members need to be able to set aside sufficient time to track grant outcomes and make appropriate recommendations. Because CCM members often have multiple obligations and priorities that compete with grant oversight, a CCM’s oversight body is

10. Ibid
expected to establish a set of clear oversight processes and hold well-planned meetings that make optimal use of the time CCM members have to devote to oversight functions.

**Focus on aspects that are critical to grant performance**: When conducting oversight, the CCM is encouraged to focus on the factors that most affect a grant’s performance. Using the following questions while reviewing grant performance helps the CCM keep the focus on the critical determinants of grant performance:

- **Financing**: Where is the money? Are disbursements timely? Have the funds been properly and immediately allocated?
- **Health product procurement**: Health products comprise a large percentage of the budget of many grants. Key questions related to health products include the following:
  - Are drugs and other health products (such as mosquito nets, laboratory materials, etc.) going where they should?
  - Are the grant implementers receiving commodities as scheduled?
  - Is the distribution system reliable?
  - Are patients receiving drugs and other products?
- **Implementation**: Are activities being carried out as scheduled? Are individuals receiving the services they need?
- **Outcomes**: Are targets being met?
- **Reporting**: Are concise and complete reports (of different types) being delivered within deadlines?
- **Technical Assistance**: Where do problems related to grant performance reside? What, if any, technical assistance is needed to strengthen capabilities and resolve problems? What are the outcomes of technical assistance?

**Communication between the CCM and PRs**: Communication between the CCM and PRs is central to good oversight by the CCM. Mechanisms should be put in place to permit regular communication between the CCM’s oversight body and PRs. PRs have the legal obligation (as reflected in the grant agreement) to submit periodic and updated reports to the CCM. The CCM’s oversight body is expected to review these reports, to analyze the information received from the PRs and to provide recommendations to the CCM for informed decision making on the actions required to improve the program’s performance.

**Transparency**: Good governance principles prescribe that each CCM act in a transparent and responsible manner in carrying out its oversight function. This is achieved through practices such as recording the proceedings of formal CCM meetings and making the proceedings available to the public. In addition, any work plans produced by the CCM and oversight reports showing progress on work plan activities should be shared with the broader public and the Global Fund. Some CCMs go further...
by creating websites that publicize the CCM’s key activities as well as program results for PRs.

**Participation by stakeholders:** It is recommended that each CCM have processes that ensure equitable participation and input from all stakeholders, including persons living with the diseases (PLWD), KPs and PRs. The CCM oversight body is expected to solicit inputs from and provide feedback to various constituencies. An example of this would be for CCM oversight body members to talk with program beneficiaries during site visits.

**5.4. HOW CAN THE CCM SUMMARY HELP THE CCM CARRY OUT ITS OVERSIGHT FUNCTION?**

CCMs require a clearly defined plan of the activities to be implemented during the oversight process and tools to facilitate implementation of these activities.

The CCM Summary has been designed specifically to facilitate that part of the oversight process that requires the CCM to review each PR’s grant performance and to address both long-term grant outcomes and short term grant implementation issues. It is important for CCMs to understand that as a tool, the CCM Summary is not an end in itself, but is a means to an end—the “end” being catalyzing improvements in PR management of grants, and ultimately, in grant performance.

As stated in the introduction to this User Guide, the objectives of the CCM Summary in the context of CCM oversight are as follows:

- To provide CCM members with data on key financial management, programmatic and PSM indicators for use in grant oversight
- Through the use of standardized indicators and color-coded thresholds linked to performance levels, to help CCM members recognize warning signs on aspects of grant implementation that require attention
- To promote dialogue between CCM members and PRs about grant management and performance
- To provide an easy format for CCM members to record and archive their recommendations and decisions on follow-up actions needed to improve grant performance
- To catalyze improved grant performance through the follow-up actions taken by both PRs and CCM members to address problems with grant performance

The CCM Summary transmits information that is essential for oversight to CCM members in an effective, concise and visual manner, with a focus on key financial, programmatic and health product and PSM indicators. In addition, the CCM Summary includes a worksheet, where CCM oversight body members identify specific issues with grant performance and propose recommended actions to the full CCM aimed at resolving problems which affect grant performance.
Use of the CCM Summary can be integrated into mechanisms already established by the CCM for oversight. For example, periodic visits by a CCM’s oversight body to the PR to review grant implementation can be used to discuss the results shown by the CCM Summary’s output. The results, comments and recommendations written into the CCM Summary can be used when the CCM oversight body is presenting and discussing grant performance with the full CCM. Outputs from the CCM Summary can be used when sharing grant performance information with stakeholders outside of the CCM, as well as with the Global Fund Secretariat in Geneva.

5.5. WHAT ARE THE KEY ELEMENTS REQUIRED FOR EFFECTIVE USE OF THE CCM SUMMARY FOR OVERSIGHT?

5.5.1. MINIMUM ELEMENTS REQUIRED FOR EFFECTIVE USE OF THE CCM SUMMARY

IT IS RECOMMENDED THAT THE FOLLOWING MINIMUM ELEMENTS BE IN PLACE BEFORE USING THE CCM SUMMARY:

- A functioning CCM oversight body with a defined structure and processes
- Timely, relevant and quality grant performance information from PRs
- A person designated by the CCM to coordinate production of the CCM Summary—a CCM Summary administrator
- A mechanism for regular transmission of performance data from PRs to the CCM Summary administrator
- Capacity among CCM members to analyze information, investigate problems and identify solutions—if this capacity is insufficient or nonexistent, it is recommended that the CCM build its capacity in these skills and practices
- A mechanism for periodic dialogue with PRs about grant performance

5.5.2. EIGHT-STAGE PROCESS TO FOLLOW AFTER ESTABLISHING MINIMUM ELEMENTS

Once these elements are in place, the following eight-stage process is proposed for periodic production of the CCM Summary and for conducting follow up on the data it provides. It is recommended that CCMs set up a schedule for this proposed process, and adapt it as needed to fit the specific country context. Because the data generated by the CCM Summary originates from PR Management Dashboard PR Management Dashboards, the process described below begins with the production of PR Management Dashboards.
Stage No. 1 – CCM receives electronic files from all PRs: The process of creating the CCM Summary begins with the delivery of each PR’s files to the CCM Summary administrator. When PRs generate their PR Management Dashboards, they do so using a file called the “Data Feed.” Each grant for which PR Management Dashboards are produced will have its own Data Feed file. Therefore all PRs will need to send their respective Data Feed files to the CCM Summary administrator. The frequency of submission of these files, and the specific mechanism for submission will be based on an agreement reached between the CCM oversight body and all PRs. The CCM Summary administrator will maintain files used to produce CCM summaries.

Stage No. 2 – CCM imports data from all PRs and produces CCM Summary: Before generating the first CCM Summary, the CCM Summary administrator uses a file called CCM Data Master to configure the main computer that will be used by the CCM to produce the CCM Summary, as described in section 3 of this manual. Once configuration is complete, the administrator imports each PR’s Data Feed file into the CCM Data Master. Once each Data Feed file is completed, the CCM Summary administrator exports the contents of the CCM Data Master to a file called “CCM Data Feed.”

Stage No. 3 – CCM Summary administrator produces the CCM Summary: In the last step to produce the CCM Summary, the CCM Summary administrator imports the CCM Data Feed into the SAP-based CCM Summary file as described in Section 4 of this manual. The CCM Summary administrator can then create interactive files (in PowerPoint or PDF) showing the CCM Summary’s data. These interactive files can be sent to members of the oversight body. Printouts can also be produced of the CCM Summary.
Stage No. 4 – CCM oversight body meets with PRs to review grant performance:
As part of this process, the oversight body holds meetings with the PRs to analyze and discuss the results shown by the CCM Summary. During the course of those meetings, the CCM Summary administrator displays the CCM Summary, presents the results section by section. The oversight body coordinator then facilitates the discussion on results between the oversight body and the PRs. A review is done of budget and financial results using the financial performance graph for the period. In addition, grant ratings and programmatic indicator results are discussed for each grant. The oversight body also reviews the data on availability of stocks of key health products and on the number of sites with stock-outs.

For each of these results, the implication for grant performance is discussed. As results are being discussed, PRs are asked to explain the reasons for deviations or color-coded alerts. CCM oversight body members may decide to ask PRs to display their individual PR dashboards to further explain their program performance. Once program results are understood and discussed, oversight body members decide on comments they wish to enter in the CCM Summary. They also make recommendations they wish to make to the full CCM to improve grant performance. Both comments and recommendations are noted by the CCM Summary administrator.

Stage No. 5 – CCM oversight body enters comments and makes recommendations in the CCM Summary: Once the CCM Summary review meeting is over, the CCM oversight body and the administrator enter the comments into the CCM Summary and define a list of recommendations to give to the CCM.

Stage No. 6 – CCM oversight body presents CCM Summary to full CCM: At a meeting of the full CCM, the CCM oversight body presents the CCM Summary results and the oversight body’s comments and recommendations related to those results. In this presentation, the oversight body highlights critical issues or bottlenecks regarding grant implementation. Ensuring the participation of a large percentage of CCM members at this meeting is important, since it provides legitimacy to CCM decisions that will affect PRs. The proceedings and decisions made at this meeting should be well documented, since the CCM will provide these meeting minutes to complete the documentation sent to the Global Fund to show compliance with eligibility requirement #3.

Stage No. 7 – Full CCM makes and records decisions made during the same meeting: Based on the presentation by and discussion with the CCM oversight body, the full CCM makes decisions, appoints individuals responsible for follow-up, and establishes deadlines for taking actions.

Stage No. 8 – Follow-up on CCM decisions in action plan: The CCM incorporates decisions made in the CCM’s action plan, which is a section contained within the CCM Summary. The CCM Summary administrator may then share copies of the CCM Summary and related documents, for example, as annexes to the minutes of the CCM.
meeting and updated action plan, with all parties concerned. If the CCM has a website, it may choose to publish the final version of each CCM Summary on the website.

The CCM oversight body must subsequently follow up to ensure that actions related to the decisions made are implemented. The CCM will be held responsible by the Global Fund for ensuring compliance with the action plan.
6. THE CCM SUMMARY IN DETAIL

The following pages provide additional explanations about the information appearing in each section of the CCM Summary. There is an image and a comment box for each image.

The CCM Summary groups information for all PRs with their respective health components and has two main tabs, “CCM Summary” and “Action Plan.”

6.1. CCM SUMMARY TAB

6.1.1. INTRODUCTION AND THRESHOLD SETTING
The tab "CCM Summary" shows data of all PRs, grouped by component: HIV/AIDS, TB, malaria, HIV/TB, and HSS (for health systems strengthening). The screenshot below shows the first three components.

Pressing this button (while staying on the "CCM Summary" tab) shows the other two components: HIV/TB and HSS (health systems strengthening)
This section provides basic information: country name, date of last update, the country's flag and the currency in which quantities are shown.

The example below shows detailed information for the HIV/AIDS component; the information options are the same for all components.

By selecting one of the PRs listed in the box, the user is able to view results for financial and programmatic indicators as well as for health products for a given grant.

During the process of setting up PR dashboards for grants, thresholds will have been determined for financial and programmatic indicators. It is recommended that thresholds be determined in an indicator-mapping workshop to facilitate obtaining input from various actors involved in implementing the grant. During the workshop, the thresholds

11. It is recommended that one workshop be held during which decision making on the following be completed: selection of thresholds for financial indicators; selection of programmatic indicators to appear in the dashboard; selection of thresholds for programmatic indicators; selection of health products to appear on the dashboard; determination of buffer stock amounts to enter in the dashboard for each health product.
for the financial indicators “Disbursed” and “Expensed” and for the programmatic indicators will need to be finalized by the PRs and the choice of currency to be used in the dashboards will be made.

Because CCM oversight body members are likely to want to contribute to the determination of these thresholds, their participation in the indicator-mapping workshop is strongly encouraged. PRs are strongly encouraged to harmonize these thresholds across grants for a given country portfolio when they are developing PR dashboards, as doing so facilitates comparison of performance across grants. Harmonization is easily achieved if PRs use the Global Fund thresholds. However, technical support teams assisting with introduction of dashboards should be prepared for situations where PRs have good reasons for insisting on different thresholds—for example, insisting on higher thresholds for “green” indicators to challenge the program to attain higher performance. When facilitating the selection of thresholds, technical-support teams facilitate the negotiation of thresholds between PRs and the CCM oversight body in situations where there is divergence between the thresholds proposed by the PR and those preferred by the CCM oversight body.

The CCM Summary is produced using data imported from multiple PR Management Dashboards; as mentioned above, it is possible that each grant may have used different thresholds to produce the green, yellow, and red colors that appear in any individual PR Management Dashboard and that these thresholds may differ from the thresholds in the CCM Summary. To ensure comparability across grants, the CCM Summary imposes common thresholds for financial and programmatic data for all PRs. Thresholds for the CCM Summary are hard coded into the software. Detailed explanation of what the thresholds are follows below in sections 6.1.2 and 6.1.3. Users should, however, be aware that if for any reason the CCM wishes to change a threshold in the CCM Summary (for example, to match the thresholds the PRs may have set for a given grant in a given year), then the Help Desk can help the CCM Summary administrator make this change. Contact information for the Help Desk can be found in section 7.3 of this User Guide.

For financial and programmatic indicators in the CCM Summary, one of three colors will appear—green, yellow, or red—to show performance of the indicator against desired progress for a given period. Green indicates attainment of desired progress, yellow indicates inadequate progress, and red indicates extremely inadequate progress.
6.1.2. FINANCIAL INDICATOR

In the financial section of the CCM Summary, the budget, disbursed, and expensed figures (all cumulative) are shown for each PR by component. Please note that the thresholds for expensed and disbursed indicators are hard coded into the software. The hard-coded thresholds for these indicators are shown in the corresponding boxes in this section.

Disbursed:

<table>
<thead>
<tr>
<th></th>
<th>Year 1</th>
<th>Year 2</th>
<th>Year 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Greater than 125% (&gt;125%)</td>
<td>Greater than 112.5% (&gt;112.5%)</td>
<td>Greater than 100% (&gt; 100%)</td>
</tr>
<tr>
<td>Yellow</td>
<td>Less than or equal to 125% and greater than or equal 100% (≤125% and &gt;100%)</td>
<td>Less than or equal to 112.5% and greater than 100% (≤112.5% and &gt;100%)</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>Less than or equal to 100% (≤100%)</td>
<td>Less than or equal to 100% (≤100%)</td>
<td>Less than or equal to 100% (≤100%)</td>
</tr>
</tbody>
</table>

The thresholds for the “Disbursed” indicator will require careful discussion to ensure that participants interpret this indicator correctly and that they understand how the ratio of expected disbursements to budget can vary throughout the life of the grant. While this ratio will differ from grant to grant, as mentioned above the CCM Summary imposes one threshold by component.

The table below shows an example of annual disbursement thresholds by year customized by PR. Please note that if, as discussed above in section 6.1.1, the CCM chooses to change thresholds, doing so will only be possible if all the grants in question have the same start date.

Annual disbursement thresholds:

<table>
<thead>
<tr>
<th>Threshold</th>
<th>Year 1</th>
<th>Year 2</th>
<th>Year 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Greater than or equal to 100% (≥100%)</td>
<td>Greater than or equal to 100% (≥100%)</td>
<td>Greater than or equal to 100% (≥100%)</td>
</tr>
<tr>
<td>Yellow</td>
<td>Less than or equal to 100% (≤100%)</td>
<td>Less than or equal to 100% (≤100%)</td>
<td>Less than or equal to 100% (≤100%)</td>
</tr>
<tr>
<td>Red</td>
<td>Less than or equal to 100% (≤100%)</td>
<td>Less than or equal to 100% (≤100%)</td>
<td>Less than or equal to 100% (≤100%)</td>
</tr>
</tbody>
</table>
In year 1, the Global Fund usually advances a quarter of the Year 2 budget. Thus, in the table above, the expected disbursement in year 1 is shown as 125% of the year 1 budget. The threshold for year 1 is greatest because the advance is a greater proportion of the total budget (one quarter advance = 25%). In year 2, the advance is still one quarter, but as a proportion of the cumulative budget this is only 12.5%. The situation is different in year 3 because by the end of a three-year period the PR should have received all the budgeted funds, and if it has the indicator will show as green. The yellow color does not appear in year 3. If all funds are not disbursed, this is cause for concern and the indicator will show as red.

With respect to the “Expensed” indicator, PRs will be encouraged by technical-support teams to apply the Global Fund’s standard thresholds as follows.12

**Expensed:**

<table>
<thead>
<tr>
<th>Green</th>
<th>Greater than or equal to 90 (≥90%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>Less than 90% and greater than or equal to 60%</td>
</tr>
<tr>
<td></td>
<td>(&lt;90% and ≥60%)</td>
</tr>
<tr>
<td>Red</td>
<td>Less than 60%</td>
</tr>
<tr>
<td></td>
<td>(&lt;60%)</td>
</tr>
</tbody>
</table>

**6.1.3. PROGRAMMATIC INDICATOR**

**Programmatic** thresholds are defined in the CCM Summary in the same way financial thresholds are defined. Thus the CCM Summary shows one common set of programmatic indicators applicable to all PRs.

---

6.1.4. ANALYSIS OF CCM SUMMARY

Selecting “See comments” will produce three new boxes: (1) a box showing the same information as before, except that the label “See comments” will have changed to “See data”; (2) a box with the list of comments, the date on which they were written, the person who wrote the comment; and (3) a box with detailed comments (this box appears blank in the screenshot below).
Selecting the "See Chart" option reveals a chart that allows the CCM to compare the amount of funding disbursed by the Global Fund with the budget. For an individual grant, the amount spent by each PR is compared with total cumulative budget for the respective PR. Financial data are cumulative by reporting period.

Selecting the information button reveals general information about a grant: Start and end date, and the applicable period for information that is displayed.
This section shows financial information about the PR: budget, disbursements, and expenditures by the PR.

<table>
<thead>
<tr>
<th>Financial Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget</td>
</tr>
<tr>
<td>1,713,609,374.23</td>
</tr>
<tr>
<td>Disbursed</td>
</tr>
<tr>
<td>1,494,884,753.64</td>
</tr>
<tr>
<td>Expensed</td>
</tr>
<tr>
<td>1,570,803,783.15</td>
</tr>
</tbody>
</table>

This section shows the 5 most important programmatic indicators for the PR. The symbol (+) allows the user to expand the box to read the full name of the indicators.
Selecting the option "See Stock" will display a chart (shown here on the right) where the CCM can see the health products that the PR considers the most important to follow up on. The CCM can also see the number of months of stock remaining for each product.

This section allows the CCM to compare the amounts budgeted, spent, and committed by the PR for pharmaceutical products for a given grant.
6.2. ACTION PLAN TAB

The “Action Plan” tab shows the recommendations submitted by the oversight committee, the decisions the CCM has made, the person responsible for doing follow-ups, the deadline established for complying with those decisions, and the follow-up status. The status will be shown in green if the decision has already been complied with; in yellow, if not yet complied with but within the deadline established; and in red if not yet complied with and the deadline established has passed.

The action plan can store up to 100 recommendations and allows you to view up to 10 recommendations at a time.
BEST PRACTICES

✓ Close Excel instances, before opening the dashboard tool.

✓ Size and resolution of the screen matters: use large monitor screens, if possible, when working on the dashboard—Use the following resolution to generate sufficiently sharp images of the dashboard: 1024 x 800.

✓ Obtain Help Desk support when needed—The Help Desk is the first level of help available for troubleshooting, followed by the technical assistance team helping with introduction of the dashboard in the respective country. Countries obtaining assistance through GMS should obtain Help Desk support by emailing GMSHelpdesk@gmsproject.org. Otherwise, PRs should contact the Global Fund at GFSupport@theglobalfund.org

✓ Tips for making presentations about the dashboard
  o Double click the ribbon in Excel to hide it and see more of the data-entry tool
  o The F11 key is a toggle key. By pressing on it you will alternately get full- and partial-screen display in browsers (for the dashboard)
  o Resize the dashboard frame in PowerPoint before entering

7. TROUBLESHOOTING, BEST PRACTICES, FREQUENTLY ASKED QUESTIONS (FAQS) AND THE HELP DESK

7.1. FAQS ON THE DATA-ENTRY APPLICATION

I opened the data-entry application and got a warning message about a macro. I cannot proceed with data-entry application set-up. What do I do?

Clicking “Enable Content” should allow you to open the data-entry application and begin working in it.

My first language is not English. Are there other language versions of the data-entry application?

You can change all the labels, instructions and error messages of the data-entry application to French or Spanish by selecting “French” or “Spanish” in the drop-down menu of the “Language” in the PR set up menu.

The CCM wishes to change indicators that PRs present. Can this be done?

The programmatic indicators in the list of products showing months of stock may be changed. The CCM must indicate to the PRs which programmatic indicators and which products should be shown in the CCM Summary. Therefore, the PR must configure those indicators and products in its dashboards and must send these in its Excel worksheets to the CCM.
**BEST PRACTICES**

- **Save as a new filename first**—Protect the master files so that you can revert back to them later if needed.

- **Use folders in a logical structure**—Try to lead by example with a clean desktop!

- **Take your time**—Errors are usually a result of attempted shortcuts (avoid dragging or copying and pasting across hidden rows).

- **Be careful when working in the data-entry application, as work sheet protection is limited!**—Work sheet protection does not protect against deliberate tampering; so exercise vigilance.

- **Do not touch sections of the data-entry application, if the User Guide does not direct you to**—If you do make a mistake, use a fresh master file to restart the process.

- **Save your work as often as you can** to avoid losing data and having to redo your work.

---

**How should the flag appear in the CCM Summary?**

1. The administrator should enter the following link: [www.flagpedia.net/](http://www.flagpedia.net/)
2. Download and save the flag for your country on your desktop.
3. Open SAP software and click on the flag.
4. Go to **View > Properties**, then select **Import**, as shown below.

   ![Flag Import Step 1](image1.png)

   1. Select the flag to insert.

   ![Flag Import Step 2](image2.png)

   Next, you will see the newly entered flag.
Whom do I contact if I encounter a complex problem with using the CCM Summary (e.g., I accidently disable key formulas)?

If you are using the CCM Summary in the context of a GMS technical assistance assignment, you should obtain technical assistance from the GMS team assigned to help you. Otherwise, contact the Global Fund Help Desk at GFSupport@theglobalfund.org.

What do I need to do if, after closing the CCM Summary, I see the following screenshot?

This message may sometimes appear after the CCM Summary is closed. Simply press the button Cancel and the message will no longer appear.

7.2. FAQS ON THE CCM SUMMARY

Can I use SAP Crystal Dashboard Design 2011 software on my Mac computer?

No, SAP Crystal Dashboard Design 2011 software is not compatible with Mac computers as of the publication of this User Guide.

Is SAP Crystal Dashboard Design 2011 compatible with Office 2013?

Yes, it is compatible.

Should I uninstall the dashboard software from my old computer before installing it in the new one? And which activation key should I use?

Yes, please uninstall the software from your old computer and then use the license key from that installation for your new computer.

I checked Microsoft Office on my computer and discovered that I have a 64-bit version of Excel. Can I still install the SAP Crystal Dashboard Design 2 2011 software successfully?

No, you will not be able to successfully install SAP Crystal Dashboard Design 2011 software until you uninstall the 64-bit version of Microsoft Office and reinstall Microsoft Office. You will then need to select the 32-bit version upon reinstallation. Follow the instructions provided on the Microsoft website for uninstalling and reinstalling Microsoft Office. You will need administrative rights to the computer you are using to do this uninstallation and reinstallation.
I generated the CCM Summary in PowerPoint but it does not show in the slide. What can I do?

To visualize the CCM Summary using PowerPoint you must click the icon to show slides at the bottom of the screen or click the F5 key on your keyboard. In the alternative check that you have version 15 of Adobe Flash Player as Adobe Flash Player is necessary to view the dashboard in PowerPoint.

When I Generated the CCM Summary in PowerPoint and I was presenting it using presentation mode, the mouse disappeared. As a result, I could not access sections of the CCM Summary that are only viewable by clicking on links. How can I avoid this in the future?

The trick to avoiding this problem is to ensure that you leave a border at the bottom of slide before you put it into presentation mode. Below is the image of what the CCM Summary looks like with a border—the border is the green strip circled in red at the bottom of the dashboard.

To create the border, open the slide in Normal view as shown below. Note that the there is no border in the example below.
To create the border, place the cursor at the bottom of the slide, and drag the cursor upward. A colored strip should appear at the bottom of the slide as shown below. Once the colored strip appears, put the slide show in presentation mode.

When back in presentation mode, move the cursor to the area of the strip whenever the cursor tries to disappear. The cursor should reappear when this is done.

I generated the CCM Summary using Adobe. However, I cannot see the image—the page is blank. What can I do to address this?

Check to see that you have the latest version of Adobe Reader (version 11 and up). If your version is out of date, update it immediately.

When working in the CCM Summary, I encountered an error message that says “Component Busy” as shown below. What should I do?
You should close all instances of Excel that are currently open and hit **Retry**. Repeat this action again if it does not work the first time.

**I generated the CCM Summary in an interactive file format in Word. However, it appears quite small, and expanding it is not easy. What should I do?**

You will need to access the “Developer” section in the tools bar of Word. By default, the Developer section does not display. However, it can be added to the toolbar. To show the Developer section, do the following:
1. Open the Word file and click on **File**
2. In the File menu, go to **Options**

![Image showing the File menu with the Options highlighted](image.png)
3. Click **Customize Ribbon**.

4. Under Customize the Ribbon and under Main Tabs, select the check "**Developer**."
5. Once installed, it is possible to modify the size of the object by selecting the option: “Design Mode.” This option shows the borders of the dashboard pages and allows changing of the size of the file.

6. Click on “Design Mode” one last time.
7.3. HOW TO GET HELP WHEN WORKING WITH THE CCM SUMMARY

The GMS and Global Fund Help Desks will operate on the assumption that most problems arising with use of the CCM Summary can be addressed by referring to this User Guide or any technical assistance team that is assisting the CCM with using the CCM Summary. Should problems arise that require more advanced technical help however, additional assistance is provided through the GMS and Global Fund Help Desks to rapidly resolve any issue; a response to this kind of request will be given within 48 hours.

The following table summarizes the approach to troubleshooting and resolution of problems with using the CCM Summary:

<table>
<thead>
<tr>
<th>Nature and timing of the problem</th>
<th>Where to get help</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The CCM's coordinator or CCM Summary administrator needs to execute normal tasks or procedures to use the CCM Summary and requires instruction. Timing could be during technical assistance visits or in between visits.</td>
<td>User Installation and Set-Up Guide.</td>
<td>Not applicable</td>
</tr>
<tr>
<td>2. During an in-country visit, a technical assistance team experiences a fundamental problem with the technology or functioning of the CCM Summary solution that it cannot resolve.</td>
<td>Consultants on the technical assistance teams. CCMs obtaining help from GMS should contact GMS. All others should contact The Global Fund.</td>
<td>In person or through email GMS Help Desk contact: <a href="mailto:GMSHelpdesk@gmsproject.org">GMSHelpdesk@gmsproject.org</a> Global Fund Help Desk contact: <a href="mailto:GFSupport@theglobalfund.org">GFSupport@theglobalfund.org</a> A response will be provided within 48 hours of receiving the message You may send emails to these addresses in English, French or Spanish</td>
</tr>
<tr>
<td>GMS consultants to contact GMS Help Desk. All others should contact the Global Fund.</td>
<td>GMS Help Desk contact: <a href="mailto:GMSHelpdesk@gmsproject.org">GMSHelpdesk@gmsproject.org</a> Global Fund Help Desk contact: <a href="mailto:GFSupport@theglobalfund.org">GFSupport@theglobalfund.org</a> A response will be provided within 48 hours of receiving the message You may send emails to this address in English, French or Spanish</td>
<td></td>
</tr>
</tbody>
</table>